
本章致力于深入解析现代硬件开发领域中极为关键的一部分———现场可编程门阵列

(Field-Programmable
 

Gate
 

Array,FPGA)的开发过程。理解FPGA背后的基本概念、特
性、内部结构以及它是如何工作的,对于深入掌握硬件设计和优化至关重要。

我们将深入了解FPGA的内部结构,包括它如何通过灵活的逻辑块、可编程的输入/输

出以及配置逻辑实现复杂的电子设计。同时,我们会讨论FPGA工作的基本原理,解析它

是如何在提供高度灵活性的同时保证性能和效率。本章会重点介绍FPGA的开发流程及

其相关工具。我们将详述从设计思想到实际硬件落地的整个开发过程,包括设计、仿真、编
译、配置和测试等关键步骤。我们也将探讨几种主要的FPGA开发工具及其特点,为设计

师选择最合适的工具提供参考。

3.1 FPGA的概念

在探讨现场FPGA之前,让我们深入了解FPGA到底是什么,它的特点,复杂的内部结

构,以及它是如何工作的。本部分旨在为读者揭示FPGA技术的核心,带领大家一步步探

索这一强大的硬件工具如何在电子设计和产品开发中扮演着不可替代的角色。通过这一系

列的探讨,读者将能够获得关于FPGA 基本概念的全面理解,为后续深入学习和应用

FPGA技术打下坚实的基础。

图3.1 FPGA芯片示意图

3.1.1 FPGA是什么

FPGA即现场可编程门阵列,是一种可编程的数字

逻辑芯片,它是在PAL、GAL、CPLD等可编程器件的基

础上进一步发展的产物。FPGA是作为专用集成电路

(ASIC)领域中的一种半定制电路而出现的,既解决了

定制电路的不足,又克服了原有可编程器件门电路数量

有限的缺点。FPGA芯片示意图如图3.1所示。
我们可以通过对FPGA编程实现大部分的数字功

能。可以说在数字世界里它无所不能,就像乐高的积木

一样可以搭建各种不同的功能模块,实现你所希望的各
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种功能。首先,你已经掌握最基本的数字逻辑知识,学会了一种用来构建各种功能的工具语

言,其次,你要动脑(考验的是你的逻辑思维是否清晰),一个优秀的建筑师的作品是在脑子

里勾画出来的,而不是拿积木碰运气拼凑出来的。

FPGA是一种非常灵活的电子器件,它允许你通过编程来定义其硬件功能。想象一下,
有一个电路板,上面有成千上万个小型电子开关(逻辑门),这些开关可以通过编程任意连接

起来,形成不同的电路。

FPGA的核心特点是它们可以在不改变物理硬件的情况下进行重新编程。这意味着你

可以设计一个电路,将其通过编程方式加载到FPGA上,如果需要改变功能或改进设计,只
需重新编程FPGA即可,而不需要重新制造整个电路板。这使得FPGA非常适合用于原型

设计、测试新的电子设计或者用于教育和研究。
在电子和计算机工程领域,FPGA经常被用于模拟复杂的电路系统,例如处理器、信号

处理电路或者用于特定应用的定制电路。由于它们的高度可编程性和灵活性,FPGA成为

电子工程师和学生实验新想法的理想选择。简单来说,如果你想设计一个电子系统,但不确

定最终需要什么功能,或者你希望能够快速迭代和测试你的设计,那么FPGA就是一个非

常有用的工具。

FPGA行业的主要厂商包括AMD(收购Xilinx)、Intel(收购Altera)、Microsemi(现为

Microchip
 

Technology的一部分),以及Lattice
 

Semiconductor。以下是这些主要厂商的简

要介绍。

•
 

Xilinx:
 

Xilinx是FPGA行业的先驱和领导者之一,总部位于美国加州圣何塞。该

公司于1984年推出了世界上第一款商用FPGA,并持续在可编程逻辑设备领域进

行创新。Xilinx的产品广泛应用于通信、工业、科学和军事等领域。2021年,Xilinx
被AMD收购。

•
 

Intel(Altera):
 

Altera是另一家FPGA行业的重要玩家,于1983年成立,在硅谷有

很大的影响力。2015年,Intel收购了 Altera,从而进入FPGA市场。Intel
 

FPGA
产品(以前的Altera品牌)被广泛应用于数据中心、通信网络和工业系统中。

•
 

Microsemi(Microchip
 

Technology):
 

Microsemi是一家提供半导体和系统解决方案

的公司,特别是在高性能和高可靠性应用方面。它在FPGA领域也有一席之地,尤其

是在航空航天和国防市场。2018年,Microchip
 

Technology收购了Microsemi。

•
 

Lattice
 

Semiconductor:
 

Lattice
 

Semiconductor是一家总部位于美国的公司,专注于

低功耗、小尺寸和低成本的FPGA产品。Lattice的FPGA主要用于消费电子、工
业、通信、计算机网络和汽车市场。

国产FPGA起步较晚,发展相对国外落后不少,主要的厂商有高云半导体、安路科技、
复旦微电子、紫光同创、京微齐力等,总体技术实力落后于国外。

3.1.2 FPGA的特点

1.
 

FPGA和CPLD的区别

  FPGA(现场可编程门阵列)和CPLD(复杂可编程逻辑器件)是一回事吗? 不是的,它
们都是可编程的数字逻辑芯片,但是有着不同的特性。它们在结构和适用场景上有一些关

键的区别。
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1)
 

结构差异

•
 

FPGA:
 

拥有更复杂的可编程逻辑块,通常包括查找表(LUTs)、寄存器和逻辑门。

FPGA的互连网络更加灵活和密集,这使得它们能够实现更复杂的逻辑功能和更高

的处理速度。

•
 

CPLD:
 

相比之下,CPLD结构更为简单。它们通常由一个较小数量的较大的可编

程逻辑块组成,这些逻辑块通过一个相对固定的互连阵列连接。CPLD中的逻辑资

源通常基于宏单元或逻辑单元,这些单元包含固定数量的逻辑门和简单的互连

结构。

2)
 

逻辑容量和速度

•
 

FPGA通常提供更高的逻辑容量和更复杂的逻辑处理能力,适合于处理大型和复杂

的设计,如数字信号处理、图像处理和自定义处理器逻辑。

•
 

CPLD由于其简单的结构,适用于较小和相对固定的逻辑应用,如简单的逻辑控制、
状态机、接口管理等。

3)
 

编程和重配置性

•
 

FPGA支持较为复杂的重配置选项,可以容纳更大规模和更复杂的设计。它们通常

通过硬件描述语言编程。

•
 

CPLD通常用于较简单的逻辑功能,编程相对简单,但其重配置能力和灵活性不如

FPGA。

4)
 

应用场景

•
 

FPGA通常用于需要高度灵活性和复杂数据处理的场合,例如在需要高性能计算、
视频处理或者复杂的数字系统集成时。

•
 

CPLD更适合小型和固定逻辑应用,如简单的控制系统、I/O扩展和固定逻辑替代,
尤其是在对功耗和成本有严格要求的情况下。

总的来说,FPGA提供了更高的灵活性和处理能力,适合复杂和高性能的应用;
 

而

CPLD则更小、更节能,适合简单的逻辑应用和成本敏感的场合。

2.
 

FPGA和处理器的区别

FPGA和微处理器、微控制器是一回事么? 不是的。FPGA相比于PC或单片机(无论

是冯·诺依曼结构还是哈佛结构)的顺序操作有很大区别,基于CPU架构的微处理器或微

控制器会执行预定义的指令(如加法、跳转、数据移动等)。这些指令是在软件层面上编写并

存储在内存中的,处理器按顺序或根据需要读取并执行这些指令。FPGA则是通过硬件描

述语言编程的,这种语言描述的是电路的物理行为。FPGA中的逻辑块和互连资源可以被

配置为直接实现特定逻辑功能的电路用于计算和信号处理。

FPGA的开发相对于传统PC、单片机的开发有很大不同。虽然FPGA的开发需要使

用硬件描述语言编程,但是编写的代码在FPGA内部实现后是一个个电路模块,各个模块

可以并行运算。这导致FPGA开发入门较难,因为它需要的不只是编程能力,还有电路

设计能力,所以FPGA开发需要从顶层设计、模块分层、逻辑实现、软硬件调试等多方面

着手。

3.
 

为什么用FPGA?

FPGA具有灵活的开发周期、更低的设计迭代成本、更低的一次性工程费用,易于评
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估和实现的可选设计架构,新产品上市时间快。相比于 ASIC和 MCU,FPGA具有以下

优势:
 

•
 

功能强大,有大量并行处理结构。可以实现数字设计领域几乎所有的功能,如组合

逻辑、时序逻辑、存储、处理器;
 

现今的FPGA芯片集成了更多功能,比如PLL时钟

产生、分配、驱动,支持各种高速接口规范的可编程I/O块,硬核化的SPI/I2C总线

以及ARM内核等,增强的DSP单元,Altera公司(现已被Intel收购)的 MAX10甚

至集成了串行ADC能够监测环境的温度。

•
 

开发快,上市时间短,适合原型设计或小批量产品。FPGA高度灵活,设计实现和后

续优化的灵活性可以显著影响项目的进度、设计的复杂度,降低项目的风险,便于更

改和升级。

•
 

重复编程/配置,灵活、快速。集成度高,可以通过选用不同规模的器件实现自己所

需要的功能,内部功能模块之间的通信和接口的速度、性能都会较多个分立的芯片

之间互连有明显的改善,节省板卡空间,便于调试。

3.1.3 FPGA的内部结构

FPGA 的 关 键 组 件,包 括 可 编 程 逻 辑 块 (Logic
 

Blocks)、可 编 程 互 连 资 源

(Programmable
 

Interconnect
 

Resources)、输入/输出块(I/O块)、存储元件、时钟管理、配置

逻辑、其他特殊功能块。FPGA内部结构如图3.2所示。

图3.2 FPGA内部结构

•
 

可编程逻辑块:
 

FPGA的核心部分是逻辑单元,通常称为逻辑单元或逻辑块。这些

是小型、可编程的数字逻辑单元,可以执行简单的逻辑操作,如与、或、非等。逻辑单

元可以被编程组合来实现更复杂的功能。

•
 

可编程互连资源:
 

为了使逻辑单元之间能够相互通信和连接,FPGA包含了大量的

可编程互连资源。这些资源包括一系列的编程线路和开关,可以根据需要配置来创

建不同的数据路径。

•
 

输入/输出块:
 

这些块连接到FPGA的外围引脚,允许FPGA与外部世界通信。I/O
块可以被配置为支持各种不同类型的外部接口标准。

•
 

存储元件:
 

大多数FPGA包含一些形式的内部存储元件,如触发器、存储器块(如
RAM块)和寄存器。这些元件可用于存储数据和中间计算结果。

•
 

时钟管理:
 

FPGA通常包含专用的时钟管理模块,如相位锁定环(PLLs),用于生成
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和管理时钟信号。这些时钟信号对于同步FPGA内部操作至关重要。

•
 

配置逻辑:
 

FPGA在上电时通过一个称为配置过程的过程被编程。配置数据通常

存储在外部存储器中,比如闪存,当FPGA上电时,这些数据被用来设置逻辑块、互
联资源和I/O块的功能。

•
 

其他特殊功能块:
 

一些FPGA还包含专用的硬件模块,如数字信号处理(DSP)块、
高速串行接口等,这些可以用于特定类型的计算任务。

3.1.4 FPGA是如何工作的

FPGA是基于查找表结构,采用了逻辑单元阵列的模式来实现组合逻辑,每个查找表

连接到一个D触发器的输入端,触发器再来驱动其他逻辑电路或驱动I/O,由此构成了既

可实现组合逻辑功能,又可实现时序逻辑功能的基本逻辑单元模块,这些模块间利用金

属连线互相连接或连接到I/O块。FPGA的逻辑是通过向内部静态存储单元加载编程数

据来实现的,存储在存储器单元中的值决定了逻辑单元的逻辑功能以及各模块之间或模块

与I/O块间的连接方式,并最终决定了FPGA所能实现的功能,FPGA允许无限次的编程。
以上内容显得有些晦涩难懂,我们可以这样理解,FPGA就像一块空白的数字电路板,

你可以根据需要来“绘制”上面的电路。当你开机时,它会从一个叫做配置文件的东西中加

载设计。这个文件告诉FPGA如何连接它内部的小组件,这些组件包括可以执行简单逻辑

操作(比如加法或乘法)的逻辑单元,以及连接这些单元的线路。你可以把它想象成乐高积

木,你可以用这些积木按照图纸搭建出各种各样的结构。

FPGA的亮点在于它的灵活性。就像你可以重复使用同一堆乐高积木来构建不同的模

型一样,FPGA可以被重新编程来执行各种不同的任务,从简单的数据处理到复杂的控制

系统。

3.2 FPGA的开发流程与工具

在FPGA的开发过程中,熟悉和掌握正确的开发流程与工具是至关重要的。本节将针

对FPGA的开发流程与工具进行深入讨论,旨在为那些寻求专业知识和技能提升的硬件工

程师和开发人员提供宝贵的资源与指南。通过本部分的学习,读者将能够获得关于FPGA
开发流程和工具的深入理解,学习到如何选择和使用合适的工具,以及如何高效地管理整个

开发过程。

3.2.1 FPGA的开发流程

FPGA的开发流程通常可以分为几个主要步骤。

•
 

需求分析与设计规划:
 

明确FPGA设计的目标和需求,进行初步的设计规划。

•
 

硬件描述语言编写:
 

使用硬件描述语言(如VHDL或Verilog)编写设计代码,描述

硬件的逻辑和功能。

•
 

代码仿真:
 

在编写代码的过程中进行仿真测试,确保代码按预期工作。

•
 

综合:
 

将硬件描述语言代码转换成电路网表,这一步骤通常由FPGA设计软件自动

完成。
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 图3.3 FPGA开发流程图

•
 

布局布线(Place
 

&
 

Route):
 

确定电路中各

个元素的物理位置,并进行布线,确保它们

能够正确连接。

•
 

生成比特流:
 

将布局与布线的结果转换成

FPGA芯片可以理解的比特流文件。

•
 

下载配置:
 

将比特流下载到FPGA芯片上,
对芯片进行配置。

•
 

硬件测试与验证:
 

在实际硬件上测试FPGA
设计,确保它在真实环境中按预期工作。

•
 

迭代优化:
 

根据测试结果对设计进行必要的

修改和优化。

FPGA开发流程图如图3.3所示。

3.2.2 FPGA开发工具

1.
 

EDA工具

  在FPGA设计的各个阶段,FPGA厂商和EDA软件公司提供了很多优秀的EDA工

具,尤其是FPGA厂商提供的集成开发环境(IDE)。熟练掌握这些设计工具能够有效提高

设计的效率,但是必须明白这些EDA软件只是一个工具,核心的FPGA 设计流程是不

变的。
目前主流的FPGA厂商Xilinx(现被AMD收购)、Altera、Intel、Lattice,都有独立的开

发平台,每个产品系列的工具会有不同,安装时需要选择对应的软件工具。

1)
 

Lattice公司

支持Windows和Linux平台的Lattice
 

Diamond、Lattice
 

Radiant。Lattice
 

Diamond软

件界面如图3.4所示。

图3.4 Lattice
 

Diamond软件界面
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2)
 

Intel
 

FPGA
支持 Windows和 Linux平台的 Quartus

 

Prime
 

Lite
 

Edition。Quartus
 

Prime
 

Lite
 

Edition软件界面如图3.5所示。

图3.5 Quartus
 

Prime
 

Lite
 

Edition软件界面

3)
 

Xilinx公司的Vivado
 

Design
 

Suite
Vivado

 

Design
 

Suite软件界面如图3.6所示。

图3.6 Vivado
 

Design
 

Suite软件界面

4)
 

在线编译工具

如苏州思得普科技有限公司开发的“小脚丫”在线FPGA综合设计平台,在浏览器里运

行,因此可以支持任何一种操作系统,且能够支持Lattice的XO2系列FPGA和Altera的

MAX10系列FPGA,适合初学者使用。“小脚丫”在线FPGA综合设计平台界面如图3.7
所示。
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图3.7 “小脚丫”在线FPGA综合设计平台界面

除原厂的集成开发环境之外,许多第三方的专业工具也可以用来做FPGA开发,最常

用的是数字电路的综合工具和仿真工具。比如综合工具Synplify和仿真工具 Modelsim。

5)
 

综合工具Synplify
 

Premier
Synplify

 

Premier软件界面如图3.8所示。

图3.8 Synplify
 

Premier软件界面

Synplify
 

Premier是一款由Synopsys公司开发的行业领先的FPGA综合工具。综合

是将高级硬件描述语言(如VHDL或Verilog)编写的设计转换为门级网表的过程,这个网

表随后用于FPGA或ASIC的布局与布线。

Synplify
 

FPGA综合工具以其能对FPGA设计产生高性能和低成本而成为业界的标准

工具。Synplify软件支持最新的 VHDL和 Verilog语言结构,包括System
 

Verilog和

VHDL-2008。该 软 件 也 支 持 多 种 不 同 的 FPGA 架 构,如 Altera、Achronix、Lattice、

Microsemi
 

and
 

Xilinx。

Synplify
 

Premier综合过程包括三方面内容。
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(1)
 

对HDL源代码进行编译,Synplify
 

Premier将输入的 HDL源代码翻译成boolean
表达式。

(2)
 

对编译的结果优化,通过逻辑优化消除冗余逻辑和复用模块,这种优化是针对逻辑

关系的,与具体器件无关。
(3)

 

对优化的结果进行逻辑映射与结构层次上的优化,最后生成网表;
 

Synplify将编译

生成的逻辑关系映射成FPGA的底层硬件模块和原语(primitive),生成网表并优化。

6)
 

ModelSim
ModelSim软件界面如图3.9所示。

图3.9 ModelSim软件界面

ModelSim是由 Mentor
 

Graphics(现为Siemens
 

EDA的一部分)开发的一款行业领先

的硬件描述语言(HDL)仿真软件。它被广泛用于验证FPGA和ASIC设计的正确性。以

下是 ModelSim的一些关键特点。
(1)

 

多语 言 支 持:
 

ModelSim 支 持 主 流 的 硬 件 描 述 语 言,包 括 VHDL、Verilog和

SystemVerilog,使其适用于多种设计流程。
(2)

 

高效的仿真性能:
 

ModelSim提供高效的仿真性能,这对于减少复杂设计的验证时

间尤为重要。
(3)

 

用户友好的界面:
 

它具有直观的用户界面,包括代码编辑器、波形查看器和调试工

具,使得设计师可以轻松地编写、测试和分析他们的HDL代码。
(4)

 

强大的调试功能:
 

ModelSim提供了广泛的调试功能,包括断点、单步执行和变量

跟踪,这些功能使得定位和修复设计错误更加高效。
(5)

 

波形分析:
 

软件能够生成详细的波形输出,帮助设计师可视化信号在时间上的变

化,从而更容易理解和调试设计。
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(6)
 

集成开发环境(IDE):
 

ModelSim通常与其他EDA工具集成,如综合工具和时序分

析工具,形成一个完整的设计和验证流程。
(7)

 

广泛的适用性:
 

从学术研究到工业应用,ModelSim在电子设计自动化(EDA)领域

内有着广泛的应用。

ModelSim的这些特点使其成为了FPGA和ASIC设计师进行 HDL代码验证和仿真

的首选工具之一。它不仅适用于大型复杂设计的验证,也适合小型或学术项目,使其在电子

设计领域内极为受欢迎。

2.
 

小脚丫(STEP)FPGA学习开发平台

FPGA的学习门槛相比单片机要高,不管是硬件成本还是设计难度,对于初学者来说都

不够友好。小脚丫(STEP)FPGA开发板是苏州思得普信息科技公司专门针对FPGA初学

者打造的一款性价比高、学习门槛低的学习模块系列。该系列中所有板子的大小兼容标准

的DIP40封装,尺寸只有52mm×18mm,非常便于携带;
 

并通过 USB端口进行供电和下

载,板上选用的芯片兼具了FPGA 和CPLD的优点,瞬时上电启动,无需外部重新配置

FPGA,是学习数字逻辑绝佳的选择。而且能够直接插在面包板上或以模块的方式放置在

其他电路板上,即插即用,大大简化了系统的设计。小脚丫(STEP)FPGA开发板如图3.10
所示。

图3.10 小脚丫(STEP)FPGA开发板

其主要产品有两个系列:
 

基于Lattice
 

XO2-4000HC
 

FPGA的STEP
 

MXO2开发板和

基于Intel(Altera)
 

MAX10M02/08
 

FPGA的STEP
 

MAX10开发板。两个产品系列除核心

的FPGA芯片不一样以外,其他板载资源和外观都是相同的。
两款FPGA都是小容量的,逻辑资源在10KB以下,并且内部集成了Flash,而一般的

FPGA都需要用户单独外配一片Flash用于存储配置文件,FPGA在上电时从外部Flash
加载配置文件并运行。STEP

 

FPGA系列开发板所选的两款FPGA无需用户外配Flash,
配置文件之间下载到芯片内部,集成度较高。

Lattice系列开发板小脚丫STEP-MXO2硬件资源介绍如图3.11所示。
硬件资源如下。
(1)

 

核心器件:
 

Lattice
 

LCMXO2-4000HC-4MG132。

•
 

132脚BGA封装,引脚间距0.5mm,芯片尺寸8mm×8mm;
 

•
 

上电瞬时启动,启动时间<1ms;
 

•
 

4320个LUT资源,96Kb用户闪存,92Kb
 

RAM;
 

•
 

2+2路PLL+DLL;
 

•
 

嵌入式功能块(硬核):
 

一路SPI、一路定时器、两路I2C;
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图3.11 小脚丫STEP-MXO2开发板硬件资源介绍

•
 

支持DDR/DDR2/LPDDR存储器;
 

•
 

104个可热插拔I/O接口;
 

•
 

内核电压2.5~3.3V。
(2)

 

板载资源。

•
 

两位7段数码管;
 

•
 

两个RGB三色LED;
 

•
 

8路用户LED;
 

•
 

4路拨码开关;
 

•
 

4路按键;
 

•
 

外部时钟频率为12MHz;
 

•
 

36个用户可扩展I/O接口(其中包括一路SPI硬核接口和一路I2C硬核接口);
 

•
 

支持的开发工具Lattice
 

Diamond;
 

•
 

一路 Micro
 

USB接口;
 

•
 

板上集成FPGA编程器;
 

•
 

支持 MICO32/8软核处理器;
 

•
 

板卡尺寸52mm×18mm。
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Intel(Altera)系列开发板如图3.12所示。

图3.12 Intel(Altera)系列开发板

硬件资源如下。
(1)

 

核心器件:
 

Intel(Altera)
 

10M08SCM153。

•
 

153脚BGA封装,引脚间距0.5mm,芯片尺寸8mm×8mm;
 

•
 

上电瞬时启动;
 

•
 

8000个LE资源,最大172KB用户闪存,378Kb
 

RAM;
 

•
 

2路PLL;
 

•
 

24路硬件乘法器;
 

•
 

支持DDR2/DDR3L/DDR3/LPDDR2存储器;
 

•
 

112个用户GPIO接口;
 

•
 

3.3V电压供电。
(2)

 

板载资源。

•
 

两个RGB三色LED;
 

•
 

2路用户LED;
 

•
 

4路拨码开关;
 

•
 

2路按键;
 

•
 

36个用户可扩展I/O接口;
 

•
 

支持的开发工具Intel
 

Quartus
 

Prime;
 

•
 

一路 Micro
 

USB接口;
 

•
 

一个10引脚的JTAG编程接口;
 

•
 

板卡尺寸52mm×18mm。
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3.3 FPGA开发流程示例

3.3.1 Lattice
 

Diamond开发FPGA实例(以STEP
 

MXO2开发
板为例)

  下面我们开始可编程逻辑的开发,以控制LED交替闪烁为例,完成自己的第一个程序。

1.
 

Lattice
 

Diamond软件的安装

Lattice
 

Diamond软件的安装注册激活过程我们不再赘述,读者可以在Lattice官网注

册登录之后获取Diamond的安装包,通过邮箱和计算机的网络地址免费申请许可证,打开

软件激活以后即可使用。下面我们重点讲解使用Diamond开发FPGA的流程。

2.
 

新建工程

1)新建Project
双击运行 Diamond软件,首先新建工程:

 

选择 File→New→Project→Next选项。

Diamond软件新建FPGA工程页面如图3.13所示。

图3.13 Diamond软件新建FPGA工程页面

2)
 

工程命名

我们将新工程命名为LED_shining,选择工程保存目录。Diamond软件新建工程命名-
保存目录页面如图3.14所示。

3)
 

添加设计文件

下一步可以添加相关设计文件或约束文件(如果已经有设计文件和约束文件,我们可以

选择添加进工程):
 

这里我们新建工程,没有相关文件,不需添加,直接单击Next按钮。

4)
 

器件选择

按照STEP
 

FPGA开发板器件LCMXO2-4000HC-4MG132C配置(器件型号必须确认

正确,否则在引脚设置时会报错)。Diamond软件新建FPGA工程-选择器件型号页面如

图3.15所示。

5)
 

选择综合工具

Synplify
 

Pro(第 三 方)和 Lattice
 

LSE(原 厂)都 可 以,我 们 就 使 用 Lattice
 

LSE。
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图3.14 Diamond软件新建工程命名-保存目录页面

图3.15 Diamond软件新建FPGA工程-选择器件型号页面

Diamond软件新建FPGA工程-选择综合工具页面如图3.16所示。

6)
 

工程信息确认

上面选择的所有信息都在这里,确认没有问题,直接单击Finish按钮。Diamond软件

新建FPGA工程-完成新建页面如图3.17所示。

3.
 

添加设计文件

工程已经建好,我们下面添加设计文件,选择File→New→File选项。选择 Verilog
 



42   

Files(选择自己使用的硬件描述语言),Name填写LED_shining,然后单击New按钮,这样

我们就创建了一个新的设计文件LED_shining.v,然后我们就可以在设计文件中进行编程

了。Diamond
 

FPGA开发-添加设计文件页面如图3.18所示。

图3.16 Diamond软件新建FPGA工程-选择综合工具页面

图3.17 Diamond软件新建FPGA工程-完成新建页面

图3.18 Diamond
 

FPGA开发-添加设计文件页面
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程序源码如代码3.1所示,将代码复制到设计文件LED_shining.v中,并保存。

代码3.1 LED_shining模块Verilog代码

module
 

LED_shining
 

 
 input

 

clk      clk
 

=
 

12mhz
 input

 

rst_n    rst_n active
 

low
 output

 

led1    led1
 

output
 output

 

led2    led2
 

output
  

parameter
 

CNT_1S=12_000_000
 

-
 

1     time
 

1S
parameter

 

CNT_05S=CNT_1S
  

1     time
 

0 5S

reg
 

 23 0 
 

cnt 
always

 

@ posedge
 

clk
 

or
 

negedge
 

rst_n 
 

begin
  if

 

  rst_n 
 

cnt
 

=1'b0 
  else

 

if
 

 cnt
 

=CNT_1S 
 

cnt
 

=1'b0 
  else

 

cnt
 

=cnt
 

+
 

1'b1 
end

wire
 

clk_div= cnt CNT_05S  
 

1'b1
 

 
 

1'b0 

assign
 

led1=clk_div 
assign

 

led2=~clk_div 

endmodule
 

4.
 

综合

程序 编 写 完 成,需 要 综 合,在 软 件 左 侧 Process栏,选 择 Process,双 击 Synthesis
 

Design,对设计进行综合,综合完成后Synthesis
 

Design显示对勾(如果显示叉号,说明代码

有问题,根据提示修改代码),Diamond
 

FPGA开发-综合页面如图3.19所示。

图3.19 Diamond
 

FPGA开发-综合页面
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通过综合工具,我们的代码就被综合成了电路,生成的具体电路,我们可以通过选择

Tools→Netlist
 

Analyzer查看(仅限 Lattice的综合工具,第三方综合工具无法查看),

Diamond
 

FPGA开发-查看综合结果页面如图3.20所示。

图3.20 Diamond
 

FPGA开发-查看综合结果页面

5.
 

分配引脚和布局布线

综合生成电路后,分配引脚,选择 Tools→Spreadsheet
 

View选项,按照图3.21分配

FPGA引脚,然后设置IOTYPE为LVCMOS33,保存。Diamond
 

FPGA开发-分配引脚页

面如图3.21所示。

图3.21 Diamond
 

FPGA开发-分配引脚页面

在软件左侧Process栏,选择Process,直接双击Place&Route
 

Design完成布局布线,如
果布局布线报错则查看引脚分配和器件型号是否匹配。Diamond

 

FPGA开发-布局布线页

面如图3.22所示。
6.

 

输出配置文件

双击Export
 

Files,所有布局布线输出依次完成。结束后,所有选项显示对勾。Diamond
 

FPGA开发-生成配置文件页面如图3.23所示。
到此,我们完成了第一个程序流文件的生成,下面可以下载到FPGA中。
7.

 

下载配置到FPGA
STEP

 

MXO2开发板的编程芯片已经集成到小脚丫开发板上,因此只需要一根USB线

和计算机相连,就可以完成供电和编程的功能,驱动安装好以后就可以开始编译下载程

序了。
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图3.22 Diamond
 

FPGA开发-布局布线页面
 

图3.23 Diamond
 

FPGA开发-生成配置文件页面

将编译完成的程序下载到开发板,将开发板、下载器和计算机连接。Diamond
 

FPGA
开发板下载连接如图3.24所示。

图3.24 Diamond
 

FPGA开发板下载连接

选择Tools→Programmer选项,选择下载器 HW-USBN-2B(FTDI),然后单击OK,进
入Programmer界面。在Programmer界面,单击右侧Detect

 

Cable,自动检测Cable
 

显示

HW-USBN-2B(FTDI),然后单击图3.25中的Program。Diamond
 

FPGA开发-程序下载

页面如图3.25所示。

图3.25 Diamond
 

FPGA开发-程序下载页面
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显示PASS,加载完成,观察STEP
 

MXO2开发板的LED交替闪烁,则表示成功了。

8.
 

设计仿真

上面我们完成了整个工程的开发过程,例程较为简单,对于复杂的工程开发需要预仿真

和后仿真等,保证最终的程序设计逻辑和时序符合我们的设计要求。仿真软件很多,这里我

们使用软件自带的 Modelsim软件进行功能仿真:
 

首先我们添加testbench文件,和前面添

加设计文件一样,选择File→New→File→Verilog
 

Files选项,Name填写LED_shining_tb,
然后单击New按钮。FPGA设计仿真-添加仿真文件页面如图3.26所示。

图3.26 FPGA设计仿真-添加仿真文件页面

测试源码如下,复制到LED_shining_tb.v文件并保存。为了方便仿真,我们在LED_

shining_tb.v调用LED_shining模块时将CNT1S重新赋值为19。LED_shining模块仿真

文件LED_shining_tb.v如代码3.2所示。
代码3.2 LED_shining模块仿真文件LED_shining_tb.v

`'timescale
 

1ns
 

 
 

100ps
module

 

LED_shining_tb 
parameter

 

CLK_PERIOD=10 
 

reg
 

clk 
initial

 

clk=1'b0 
always

 

# CLK_PERIOD 2 
 

clk=~clk 

reg
 

rst_n    active
 

low
initial

 

begin
  rst_n=1'b0 
  #20 
  rst_n=1'b1 
end

wire
 

led1 led2 
LED_shining#  CNT_1S

 

 
 

19
 

  
 

u_LED_shining
 

 
  clk           

 

clk    
  rst_n          

 

rst_n   
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  led1           
 

led1    
  led2           

 

led2   
  

endmodule
 

然后在软件左侧Process栏,选择File
 

List,找到LED_shining_tb.v(必须保存过),右击,选
择Include

 

for→Simulation选项。FPGA设计仿真-设置仿真文件属性页面如图3.27所示。

图3.27 FPGA设计仿真-设置仿真文件属性页面

准备工作完成,我们选择Tools→SimulationWizard→Next选项,开始建立仿真工程。

Lattice
 

Diamond
 

3.12版本软件自带ModelSim仿真工具,直接调用ModelSim(默认),工程

名称填写LED_shining_tb,工程路径默认即可,然后单击Next按钮。FPGA设计仿真-选
择仿真工具页面如图3.28所示。

图3.28 FPGA设计仿真-选择仿真工具页面

选择RTL级仿真。下一步勾选Copy
 

Source
 

to
 

Simulation
 

Directory,然后单击Next
按钮,调用 ModelSim软件。FPGA设计仿真-选择RTL级仿真页面如图3.29所示。

启动 ModelSim软件,可以直接查看testbench文件中变量的时序变化,想要看LED_

shining模块中的变量的时序,可以通过图3.30中的步骤添加信号至 WAVE窗口。FPGA
设计仿真-在 ModelSim中添加观察信号页面如图3.30所示。



48   

图3.29 FPGA设计仿真-选择RTL级仿真页面

图3.30 FPGA设计仿真-在 ModelSim中添加观察信号页面

在 WAVE窗口仿真相应的时间长度,观察信号的时序。FPGA设计仿真-在ModelSim
中观察信号时序页面如图3.31所示。

图3.31 FPGA设计仿真-在 ModelSim中观察信号时序页面
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至此,我们完成了使用Diamond软件进行FPGA开发的完整流程。

3.3.2 Intel
 

Quartus
 

Prime开发FPGA实例(以STEP
 

MAX10
开发板为例)

1.
 

软件安装

Quartus
 

Prime是Intel(原Altera)公司的综合性PLD/FPGA开发软件,设计能力强

大,接口直观易用,具有运行速度快、界面统一、功能集中、易学易用等特点。Quartus
 

Prime
有Lite、Standard和Pro三个版本,不同版本可适用的器件和功能不同,其中Lite可用于

MAX10系列FPGA的开发,而且是免费的。
下载安装包注意:

 

选择软件版本和操作系统,同时勾选Quartus
 

Prime、ModelSim-Intel
 

FPGA
 

Edition和 MAX
 

10系列器件支持。大家可以去Intel
 

FPGA官网下载,具体下载和

安装过程我们不再赘述。

2.
 

新建工程

1)
 

创建工程

双击Quartus系列软件图标,启动软件,单击File→New
 

Project
 

Wizard选项或单击

Home页面中的 New
 

Project
 

Wizard图标。Quartus
 

Prime
 

Lite
 

Edition软件界面如图3.32
所示。

图3.32 Quartus
 

Prime
 

Lite
 

Edition软件界面

2)
 

工程目录、名称填写

(注意:
 

工程目录中不能有汉语、空格等字符)。Quartus
 

Prime新建工程-设置工程名

称和目录页面如图3.33所示。

•
 

工程目录:
 

选择新建工程的目录。

•
 

工程名称:
 

填写工程名称。

•
 

顶层模块名称:
 

设计文件中顶层模块名称要跟工程名称相同。

•
 

工程类型:
 

选择Empty
 

project。
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图3.33 Quartus
 

Prime新建工程-设置工程名称和目录页面

  3)
 

添加设计文件

如果已有设计文件,在当前页面选择并添加,也可以不添加,工程新建完成后再创建新

文件。

4)
 

器件选择

根据开发平台使用的FPGA选择对应器件型号(10M02SCM153I7G/10M08SCM153C8G)
页面如图3.34所示。

图3.34 Quartus
 

Prime新建工程-选择器件型号页面
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5)
 

EDA工具选择

选择第三方EDA工具,如果有需要可以选择第三方的综合或仿真工具(第三方工具需

要另外安装并设置启动路径),这里我们选择使用 ModelSim工具仿真。Quartus
 

Prime新

建工程-选择综合和仿真工具页面如图3.35所示。

图3.35 Quartus
 

Prime新建工程-选择综合和仿真工具页面

6)
 

工程信息确认

确认工程相应的设置,如需调整单击Back按钮返回修改,若确认设置,则单击Finish
按钮。Quartus

 

Prime新建工程-工程信息确认页面如图3.36所示。

图3.36 Quartus
 

Prime新建工程-工程信息确认页面
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3.
 

添加设计文件

(1)
 

选择File→New选项,或单击工具栏中的New按钮,选择Verilog
 

HDL
 

File文件

类型,单击OK按钮,Quartus软件会新建并打开Verilog文件。
(2)

 

在新建的 Verilog文件中进行 Verilog
 

HDL代码编写、保存,文件名为 LED_

shining.v,程序源码如代码3.3所示。Verilog
 

HDL代码编写、保存页面如图3.37所示。

图3.37 Verilog
 

HDL代码编写、保存页面

代码3.3 Intel
 

FPGA开发案例LED_shining.v模块

module
 

LED_shining
 
input

 

clk_in 
 

    clk_in
 

=
 

12mhz
input

 

rst_n_in 
 

  rst_n_in 低电平有效

output
 

led1 
 

  led1
 

输出

output
 

led2   led2
 

输出

  

parameter
 

CLK_DIV_PERIOD=12_000_000 
 

reg
 

clk_div=0 

  wire
 

led1 led2 
assign

 

led1=clk_div 
assign

 

led2=~clk_div 

reg 24 0 
 

cnt=0 
always@ posedge

 

clk_in
 

or
 

negedge
 

rst_n_in 
 

begin
  if  rst_n_in 

 

begin
     cnt =0 
     clk_div =0 
  end

 

else
 

begin
     if cnt== CLK_DIV_PERIOD-1  

 

cnt
 

=0 
     else

 

cnt
 

=cnt
 

+
 

1'b1 
     if cnt CLK_DIV_PERIOD 1  

 

clk_div
 

=0 
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     else
 

clk_div
 

=1'b1 
  end
end

endmodule
 

4.
 

分析综合

(1)
 

选择菜单栏中的Processing→Start→Start
 

Analysis
 

&
 

Synthesis选项,或单击工具栏

中的Start
 

Analysis
 

&
 

Synthesis按钮,Quartus
 

Prime分析综合操作步骤页面如图3.38所示。

图3.38 Quartus
 

Prime分析综合操作步骤页面

(2)
 

Quartus软件会完成分析综合,若设计没有问题,综合 Tasks栏中 Analysis
 

&
 

Synthesis会变成深色,同时左侧出现对勾。Quartus
 

Prime综合完成显示综合结果页面如

图3.39所示。

图3.39 Quartus
 

Prime综合完成显示综合结果页面
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(3)
 

综合完成后可以选择Tools→Netlist
 

Viewers→RTL
 

Viewer查看电路。Quartus
 

Prime查看综合后电路页面如图3.40所示。

图3.40 Quartus
 

Prime查看综合后电路页面

5.
 

引脚约束

(1)
 

选择Assignments→Device打开器件配置页面,然后单击页面中的Device
 

and
 

Pin
 

Options…选项打开器件和引脚选项页面。Quartus
 

Prime配置器件和引脚选项页面如

图3.41所示。

图3.41 Quartus
 

Prime配置器件和引脚选项页面
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  (2)
 

在Unused
 

Pins选项中配置Reserve
 

all
 

unused
 

pins为
 

As
 

input
 

tri-stated状态。

Quartus
 

Prime配置引脚模式页面如图3.42所示。

图3.42 Quartus
 

Prime配置引脚模式页面

(3)
 

在Voltage选项中配置 Default
 

I/O
 

standard为
 

3.3-V
 

LVTTL状态。Quartus
 

Prime配置引脚电平页面如图3.43所示。

图3.43 Quartus
 

Prime配置引脚电平页面

(4)
 

选择菜单栏中的Assignments→Pin
 

planner选项,或单击工具栏中的Pin
 

planner
图标,进入引脚分配界面。在Pin

 

Planner页面中将所有端口分配对应的FPGA引脚,Quartus
 

Prime引脚分配页面如图3.44所示,然后关闭(自动保存)。
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图3.44 Quartus
 

Prime引脚分配页面

6.
 

编译(布局布线&生成配置文件)
选择菜单栏中的Processing→Start

 

Compilation选项,或单击工具栏中的Start
 

Compilation
按钮,开始所有编译,等待Tasks列表中所有选项完成,Quartus

 

Prime编译完成页面如图3.45
所示。

图3.45 Quartus
 

Prime编译完成页面
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7.
 

下载到FPGA
(1)

 

使用micro-usb线将STEP-MAX10开发板连接至计算机 USB接口,选择菜单栏

中的Tools→Programmer选项,或单击工具栏中的Programmer按钮,进入烧录界面。选

择Hardware
 

Setup选项,选择硬件驱动为USB-Blaster[USB-0]。Quartus
 

Prime编程下载

及驱动设置页面如图3.46所示。

图3.46 Quartus
 

Prime编程下载及驱动设置页面

(2)
 

确认驱动为USB-Blaster[USB-0]后,选择Add
 

File添加工程输出文件中的pof格

式文件,勾选Program列和Verify列,单击Start按钮进行FPGA加载。Quartus
 

Prime选

择编程文件并启动下载页面如图3.47所示。

图3.47 Quartus
 

Prime选择编程文件并启动下载页面
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(3)
 

FPGA加载完成,界面中Progress状态显示100%(Successful)。
至此,我们完成了LED_shining示例的开发流程,可以观察开发板现象。

8.
 

设计仿真

Quartus
 

Prime在安装时可选择仿真软件是否一起安装,最新的版本 Quartus
 

Prime
 

23.1可一起安装适用Intel
 

FPGA的QuestaSim,之前的版本可选择安装 ModelSim-Intel
 

FPGA。当然我们也可以自己安装第三方仿真软件,除 QuestaSim和 ModelSim以外还可

以安装 Active-HDL、Riviera-PRO 等仿真软件。所以仿真软件是独立存在的,Quartus
 

Prime只是预留了启动接口。
(1)

 

仿真文件:
 

提前准备测试文件(Textbench)LEDshiningtb.v,测试文件源码见代码3.2。
(2)

 

选择菜单栏中的Assignments→Settings选项,或单击工具栏中的Settings按钮,
进入设置界面。选择菜单栏中的Simulation选项,单选 Compile

 

test
 

bench,单击 Test
 

Benches按钮。Quartus
 

Prime仿真设置界面如图3.48所示。

图3.48 Quartus
 

Prime仿真设置界面

(3)
 

单击 Test
 

Benches按钮后,在弹出的对话框中单击 New按钮,填写 Test
 

bench
 

name,按照目录添加测试文件,如图3.49标识顺序,最后单击 OK按钮回到设计界面。

Quartus
 

Prime仿真设置-添加测试文件界面如图3.49所示。
(4)

 

选择菜单栏中的Tools→Run
 

Simulation
 

Tool→RTL
 

Simulation选项,或单击工

具栏中的RTL
 

Simulation按钮,Quartus软件会自动启动 Modelsim软件。Quartus
 

Prime
仿真设置-启动RTL仿真界面如图3.50所示。

(5)
 

ModelSim软件启动后自动完成代码编译,ModelSim 仿真-启动界面如图3.51
所示。
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图3.49 Quartus
 

Prime仿真设置-添加测试文件界面

图3.50 Quartus
 

Prime仿真设置-启动RTL仿真界面

(6)
 

选择需要观察波形的信号,右击,在弹出的快捷菜单中选择Add
 

Wave选项,这样

就将对应信号添加至 Wave窗口。ModelSim仿真-添加观察信号界面如图3.52所示。
(7)

 

ModelSim仿真-设置仿真时间启动仿真界面如图3.53所示。在弹出的 Wave窗口中

单击工具栏中的Restart按钮,在弹出的Restart窗口单击OK按钮,复位仿真 Wave窗口。修

改工具栏中仿真时间,单击工具栏中的Run按钮,进行仿真,仿真波形如图3.53所示,仿真完成。
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图3.51 ModelSim仿真-启动界面

图3.52 ModelSim仿真-添加观察信号界面

图3.53 ModelSim仿真-设置仿真时间启动仿真界面
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3.3.3 小脚丫FPGA(STEP
 

FPGA)线上开发平台

FPGA的集成开发软件(IDE)往往都非常庞大,所需安装空间少则几 GB多则几十

GB,运行时对内存和CPU也有要求。针对以上问题,小脚丫FPGA开发了一款FPGA线

上开发平台,将IDE安装至服务器端,用户在网页端完成所有的开发操作和信息交互,目前

支持STEP
 

MXO2和STEP
 

MAX10
 

FPGA开发板的开发设计。
在小脚丫网站www.stepfpga.com注册账号后就可以体验使用线上设计工具,基于浏

览器端的开发环境,无需下载FPGA设计工具到本地计算机,使用方便简单。STEP
 

FPGA
线上开发平台主页如图3.54所示。

图3.54 STEP
 

FPGA线上开发平台主页

1.
 

新建项目

单击新建项目会进入创建新项目界面,左侧是项目文件组成,可以在这里查看项目所需

文件以及软件生成的日志等。在上方是FPGA设计的流程图标,可以按顺序创建源文件、
综合、分配引脚、产生编译文件、仿真以及下载工程和编译文件。

填写项目的一些基本信息,例如项目名称、设备、项目标签、描述等。STEP
 

FPGA线上

开发平台-新建项目页面如图3.55所示。

2.
 

创建源文件

提交创建项目后进入编辑界面,单击界面上的“+”号可以新建源文件(也可以从其他项

目复制文件)。STEP
 

FPGA线上开发平台-新建文件页面如图3.56所示。

3.
 

设置顶层文件

源文件创建完成后需要确认顶层文件,STEP
 

FPGA线上开发平台-设置顶层文件页面

如图3.57所示,单击左侧栏文件名称后的箭头图标。设置完成后文件名称后的箭头图标消

失,说明该文件目前是顶层文件。如果项目中包含多个源文件,也进行同样设置。

4.
 

逻辑综合

设置好顶层文件后单击“逻辑综合”,开始进行综合。综合完成后显示日志,如果有错误
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图3.55 STEP
 

FPGA线上开发平台-新建项目页面

图3.56 STEP
 

FPGA线上开发平台-新建文件页面

的话会显示报错信息。STEP
 

FPGA线上开发平台-逻辑综合页面如图3.58所示。

5.
 

引脚分配

综合通过后进行引脚约束。这里主要对FPGA引脚的编号进行分配。STEP
 

FPGA线

上开发平台-引脚分配页面如图3.59所示,小脚丫板卡可配置的引脚分为板上部分

(Internal)和扩展部分(External)。板子上的数码管、拨码开关、按键、LED和三色灯属于板

上部分。板子两侧扩展的IO引脚属于扩展部分。
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图3.57 STEP
 

FPGA线上开发平台-设置顶层文件页面

图3.58 STEP
 

FPGA线上开发平台-逻辑综合页面

分配引脚过程很简单,单击想要分配的外设,会自动弹出所有的输入输出信号,选择确

定就可以。所有信号分配完毕单击保存按键,如果分配错误可以选择重置。板上外设被分

配使用后会以黄色来标记。

6.
 

映射生成流文件

分配完成后单击“FPGA映射”按钮来产生FPGA的配置文件,完成后生成日志,如果
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有错误会显示报错信息。STEP
 

FPGA线上开发平台-FPGA映射页面如图3.60所示。

图3.59 STEP
 

FPGA线上开发平台-引脚分配页面

图3.60 STEP
 

FPGA线上开发平台-FPGA映射页面

7.
 

下载文件

可以在下载界面下载打包整个工程,也可以只下载需要的FPGA编程流文件(Lattice
小脚丫产生jed文件,Intel小脚丫产生pof和sof文件)。STEP

 

FPGA线上开发平台-下载

文件页面如图3.61所示。

8.
 

仿真工具使用

小脚丫线上设计工具也可以进行在线功能仿真操作,方便验证设计。

1)
 

新建仿真文件

单击新建文件,会弹出窗口,定义文件名称,然后记得勾选“设为仿真文件”选项。
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STEP
 

FPGA线上开发平台-新建仿真文件页面如图3.62所示。

图3.61 STEP
 

FPGA线上开发平台-下载文件页面

图3.62 STEP
 

FPGA线上开发平台-新建仿真文件页面

2)
 

编辑仿真文件

编辑仿真文件然后保存。STEP
 

FPGA线上开发平台-编辑仿真文件页面如图3.63
所示。

3)
 

仿真并查看波形

单击“开始仿真”,结束后可以看到输出波形,如果出错请查看出错信息。STEP
 

FPGA
线上开发平台-查看仿真波形页面如图3.64所示。
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图3.63 STEP
 

FPGA线上开发平台-编辑仿真文件页面

图3.64 STEP
 

FPGA线上开发平台-查看仿真波形页面


